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Edit Extended Access List Object

Name

I Redirect_traffic

Entries (3)

Allow Overrides
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2) WCCP 220[RIES Alst7| QI8 AML S2S MY

Name

[ weee-cuenT

Entries (1)

Sequence  Actior Source Source Port Destination Destination Port Application Us: SGT
1 Sallow  WSA_saiver s u
Allow Overrides
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2EHA|: Object(7HAll) > Object Management(7H&l| 2 2[) > FlexConfig > Text Object(El A E JHA|) >
Add Text Object(®IAE JiA| F7})E 0[&35t01 WCCP MH|AE FItetm MEELICH



Edit Text Object T

Mame:

Description:
Variable Type Count
Single v 1
1 a7

|| Allow Overrides

| Cancel | Save

weep AMHIA THAE BtEE &
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3EHA:

« Object(7HA) > Object Management(7HA| & 2[) > FlexConfig > Text Object(E A E JiA|) 2 O]

55} isServiceldentifiers Z4A4gtL|C}.

Text Object ['\"« isServiceldentifie] b4

or be a list of multiple values

Text objects define free-form text strings that you use as variables in a FlexConfig object. These objects can have single values


https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html
https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html
https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html
https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html

« isServiceldentifierE false0ll A true2 £=7%%t
« isServiceldentifier - false@l A< EZ& web-cacheservice
Management Center Z1I|28|0|M 710|E EM & X

AEXIE AFE & LICEH Firepower

Edit Text Object

Name:

iIsServiceldentifier

Description:

A flag to identity whether to use
service in wecep.

Variable Type
Single

1 true

Allow Overrides

» Override (0)

o
a

£ falseOl| A true2 =L}

Count



https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-v70/flexconfig_policies.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-v70/flexconfig_policies.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-v70/flexconfig_policies.html
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ATHA:

« Object(7HA) > Object Management(7HA| & 2[) > Flex Config(Flex 743) > FlexConfig
Object(FlexConfig 7HA) 2 0|S & LIC}.

« weep 7|RIEE AMELICEH

« Wcep_Configure Bl Z &!0f| CiEt Clone M2 E=2IFLICH
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Address Pools FlexCon
Application Filters
AS Path

BFD Template

Cipher Suite List

DHGP IPvG Pool
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> Extarmal Attributes

File List
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FlexConfig Object
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Add FlexConfig Object (7]
Name:

Weep_Configure_clone
Description:

The template is an example of

weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert « Deployment: Once v Type: Append v
#set( $service = "web-cache")
#if( $isServiceldentifier == "true")
#set( Sservice = “$sepviceldentifier”
sl —

fset ( SwccpCli = "wccp")

#end
###fweccpRedirectlist is place-holder for extended ACL.
####Replace pRedirectlList with extended ACL defined in FMC by inserting policy-object of type extended ACL.
#if{ SwecpRedirectList )
fset | SweepCli = "SweopCli redirect-list $weogpRedirectList™)
fend
¥ Variables
Name Dimension Default Value il Override Description
(Type:Name) P
isServiceldentifier SINGLE true FREEFORM:I... false A flag to determine if service ...
serviceldentifier SINGLE 1 FREEFORM:... false service identifier number is to...

Cancel Save

—

MH|A AR AA

« 2EHAH|0| M BHE B4 Z2 Text Objectwcep-serviceS 4 g LICtH
« EECH2 HIF0lA Insert > Insert Policy Object > Text ObjectE ME4EL|C}H



Add FlexConfig Object

Name:

' Weep_Configure_clone

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

| Insert B Deployment: | Once v Type: | Append
| Insert Policy Object Text Object

Insert System Variable » Network

Insert Secret Key Security Zones

#set ( SwecepGli = "Sweg

####wcepGroupList is pl Standard ACL Object 3 acr.

####Replace wecepGroupLi 2fined in FMC by inserting policy-object of type extended ACL.
Fif ( $wecpGroupList ) Extended ACL Object

fset( SweepCli = “Sweer JupList")

#end Route Map

####weccpRedirectlist is place-nolaer ror extended ACL.

fend
wcep-service 2R E B2 4 AEFLICH

« Variable Namewccp -serviceE M&&L|C}.
« A8 7hs 8 FHA 0l M weep-service-objectE A EFLCH
- X E FIt5tm MEELICH



Insert Text Object Variable (7]

Variable Name:

| wecep-service ‘

Description:
Available Objects Selected Object
| 2, weep b4 ‘ weep-service-object .

WCCp-=-5erv [ ce-o

wecepPassword

Cancel Save

weep-service FWR =7t
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Add FlexConfig Object

MName:

l Weep_Configure_clone l

Description

The template is an example of
weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

l Insert » s Deployment: | Once v Type: | Append v

#set( $service = "web-cache")

#if( $isServiceldentifier == "true")
#set( $service = "$wegp-service"”)
#end

et 1 ( $WCCRGLOUPLiSE )
: #set( SweepCli = "$weepCli group-list $weepGrouplist")

#end

M HO|El weepGrouplList #4> X 74

- EECHR HIFlA Insert(&f &) > Insert Policy Object(&= 7| 4 2l) > Extended ACL
Object(Z& ACL 7HA)E MEHFLICH

Name:

[ Weep_Configure_clone |

Description:

The template is an example of i
wecep configuration. It can not be |

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v i Deployment: . Once v | Type: | Append

Il Insert Policy Object Text Object

Insert System Variable »  Network

Insert Secret Key Security Zones

- is pl Standard ACL Object 3 acrL,

####Replace weepGrouplLi rfined in FMC by inserting policy-object of type extended ACL.
$if( ) Extended ACL Object

#set ( SwcepCli = "Swecce >upList™)

#end Route Map

#end

¥ Variables

weepGrouplist =& ACL 7}



« O|™ EtAHO|M S AFSH weepGroupList 0|8 € B4 0|8 MMof 20 d&LCt
« 1EHAHI| A M5 El Available Objects(At8 7ts 8t 7)ol A WCCP-CLIENTE A4 L|Ct.
o F7b U MHEELICH
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Insert Extended Access List Object Variable (7]

Variable Name:

; ‘ wccepGrouplList |

Description:

Available Objects C Selected Object

| | search X | Bvcep-CLIENT ¥
.

I-§2edin=\.ct_traﬂ°|c

7t

B

WCCP-CLIENT E & 25
7CHA:

- wcepRedirectListE MEH5H04 TRt ¢+ 8 S AT MBS ELCt.



Add FlexConfig Object

Name:

( Weep_Configure_clone ]

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v Deployment: { Once v ‘ Type: | Append
f#set ( $service = "web-cache")
#if( $isServiceldentifier == "true")
#set( $service = "Swccpmservice”)
#end
#set ( SweepCli = "wecp")
#set

####Replace
————-#if ( $WcCpRed

#end

weepRedirectList M| 74

« EELCI2 HIFOoM Insert > Insert Policy Object > Extended ACL ObjectE AMEHEHL|CH.

Add FlexConfig Object

Name:

[ Wecep_Configure_clone ]

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v | Deployment: ' On-::_e__ L Type: __&_p_:p_e_njq_

| Insert Policy Object Text Object

Insert System Variable » Network

Insert Secret Key Security Zones
#set [ SWegpCll = "SWeC ;
####wcepGrouplist is pl Standard ACL Object 4 acL.
#4#4Replace woepGroupLi X fined in FMC by inserting policy-object of type extended ACL.
#if( ) Extended ACL Object
#set ( SwecpCli = "Sweep oupList™)
#end Route Map

###¥wccpRedirectlist is place-nolaer ror extended ACL.
###4Replace weepRedirectList with extended ACL defined in FMC by inserting policy-object of type extended ACL.

#end

¥ Variables

wcepRedirectListol] CHEF =& ACL 7HR| A1E4

r

« B 0|& 0 weepRedirectList® £0{g& LIC}



« Available Objecto| A Redirect_traffice A4 L|C}.
« Add(F7hHE d=ist T XqFELICH

e el eileeiliaeosiisisaiiisisisiiisneiios e = = e e e e

Insert Extended Access List Object Variable @

Variable Name:

‘ wccpRedirectList ‘

Description:

Available Objects C Selected Object
’ Q_ Search p 4 Lﬁzeo:jirect_traﬁ“lc

£ Redirect_traffic

#VCCP-CLIENT

)

Redirect_traffic ACL &7}
8EHA[:

o @wccpPassword X7



Add FlexConfig Object

Name:

Wecep_Configure_clone ‘

Description:

The template is an example of
wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

| Insert v [ Deployment: | Once v | Type: | Append v

FMC by inserting policy-object of type extended ACL.

t is place-holder for extended ACL.
irectList with extended ACL defined in FMC by inserting policy-cbject of type extended ACL.

#set( SwccpCli = "SwecpCli password @wccpPassword ")
SweepCli

#foreach( $interfaceName in $security-zone)

A HOIEl weeppasswordE M7AZ& LICEH

- EECIR HIFolM Key(71)2 MEHEILICE Insert(4F Q) > Insert Secret Key(HIE 7| 42)).

Add FlexConfig Object

Name:

Weep_Configure_clone

Description:

The template is an example of
weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

‘ Insert = £ Deployment: Once v l Type: [ Append

Insert Policy Obiect » ace-holder for extended ACL.
Y g st with extended ACL defined in FMC by inserting policy-object of type extended ACL.

Insert System Variable » . . :
Y Cli group-list S$weepGroupList™)

Insert Secret Ke
place-holder for extended ACL.

###4Replace weccpRedirectList with extended ACL defined in FMC by inserting policy-object of type extended ACL.

#foreach({ $interfaceName in $security-zone)

¥ Variables

Hll:ll 9| A EH

= —_

« Add Secret Key(H|Z 7| &7HE Z=/gfLICH



Insert Secret Key

Add Secret Key

Name

[ ] weccpPassword

,
-

HIY 7] =7t

. H|Z 7| 0|=0f 0|EE ¢
« Password(H|ZHE)E 2

=
« Confirm Password(H| %/

l'll

24tk
248fL|C},

5 gfelol sYst



Add Secret Key

Secret Key name:*

‘ wccpPassword

Password:*

[ Cancel ’

Add
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Edit FlexConfig Object

Name:

| Weep_Configure_clone

Description:

The template is an example of
weep configuration. It can not

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

&

Deployment: | Once

v | Type: | Append

fend

¥ Variables

Name

wcepGrouplist
wcecp-service
interfaceName

security-zone

E of ojod
- O

ol

il

- EECH2 M0l M Security Zones(E
Object( = JHA| &) E MEHEFLICEH

= A

Dimension

SINGLE

SINGLE

SINGLE

SINGLE

Default Value

WCCP-CLIENT

97

o} ojod
- O

)=

Property
(Type:Name)

EXD_ACL:W...

FREEFORM:...

SECURITYZ...

SECURITYZ...

MBS T Insert(

Override Description

false

false

false

false

A2y > Insert Policy



Add FlexConfig Object

Name:

Wecep_Configure_clone

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

[ Insert B2 Deployment: I Once v | Type: I Append
Insert Policy Object Text Object supList™)
Insert System Variable »  Network wded ACL.
. defined in FMC by inserting peolicy-object of type extended ACL.
Insert Secret Key Security Zones
#SEL( PWCCPLLl = "3WCCE JRedirectList”)
$end Standard ACL Object

¥set( SwccpCli = "Sweep Extended ACL Object  yord ")
SweepCli Route Map

##4# RAssiging wcop onto interface
#foreach( in $security-zone)

#end

¥ Variables

HOt oy My

[ |

. B2 0|2ES HoF gdodoz Eo{daLc}.
+ Available Objects(AHS 7Hs 8t THA)OIM Add(F7HE QIE{TIO|A S ML
. xiztg BYELIL



Insert Security Zone Variable (7]

Variable Name:

| security-zone |

Description:

Available Objects Selected Object
| C, Search ‘ in

o/

dmz

out

Cancel Save

« Devices(C|HF0|A) > FlexConfig(FlexConfig)Z 0|5 504 New Policy(Al Z%H) EE = Edit an
existing policy(7|& H +=H)E F =& LICt.

« 7 MEl Weep_configure_clone 24| E MENSI T >& F2l5t0{ € F & LICH
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WCCP_config

<7 Selected Append FlexConfigs

11E-AH|: Deploy(T%) > Select the FTD Device(FTD C|HIO|A AEH) > Deploy(T5)2 O|S & LCt.



_n
_|
O
0
r
=]
Hu
I
o
9'|_|
d
0%
o
mjo
>
0%
I
L
o
g
=
c
=
3
8
3
E:
g
=

ZAI| a8y 0|M O Al

wccp 97 redirect-1ist Redirect_traffic group-Tist WCCP-CLIENT password ###*%*%*
wccp interface inside 97 redirect in

Au|aefolddol 2HHE HIFHE 7 UK 2 leted™H BPS A=—AefL/ct
1) system support diagnostic-cli

2) enable

3) HIZHH S ¢i0| Enter& F+&LICt

4) more system:running-config | include wecp

2EHA|: wCCP &HEf 20l

l:c'=>1Ec'=>l 2 oH show wcep

ol

Global WCCP information:
Router information:
Router Identifier: -not yet determined-
Protocol Version: 2.0

Service Identifier: 97

Number of Cache Engines: 1

Number of routers: 2

Total Packets Redirected: 0

Redirect access-1ist: Redirect_traffic
Total Connections Denied Redirect: 0

Total Packets Unassigned: 0

Group access-Tist: WCCP-CLIENT
Total Messages Denied to Group: 0

Total Authentication failures: 0

Total Bypassed Packets Received: 0

2 Al™ show weep 97 AMH|A

WCCP service information definition:



Type: Dynamic

Id: 97
Priority: 240
Protocol: 6
Options: 0x00000012
Hash: DstIP
A1t Hash: -none-
Ports: Destination:: 80 443 000000

Zr1: 0{7|M 972 service-idLICEH WCCP Z2I0|HE|M &8t T E HE E [ZE]0]
ME £ UasLc MM B ESHAAIR.

3) Run the command show wccp 97 view

=X &



rr

E{Ho|AQS| AEE 7K1

1CHAH|: FTD7F ZEA| MBHo|M WCCP &g dte 7dat S st ¢l
X| &lghL|ct,

ol o= Eci=o| DMZ QlE{Ho|A 2 2|C|HMEELICE

>show route
S 10.xx.xx.xx 255.yyy.yyy.yyy [1/0] via 10.zz.zz.z, dmz

B 0471 10.xx.xx.xx2 ZEA| MH IPO|12, 255.yyy.yyy= HOFA T O|MH, 10.zz.zz.z&
CtE & Ho|EQ oLt
2EHA: LHE & dmz QIE{H|O| A0 ZMHE == sto] EE{E 0| 2|C|HME|E = EfLICt

EE 4439 LIE QE{H 0| A0 M 2%



capture capinside interface inside trace detail match tcp any any eq 443

DMZ QIE{H|O| A Of ZHX:

capture capdmz interface dmz trace detail match gre any any

2t 1: DMZ QIE{H 0|20 GRE Z2EE 2 ZE{Z!5HoF ghLCt. 2IC]
Zlo| M weep EEH0|IER Z=5HELICEH

A
3EHA: weepdl CHE ClH{

He Ay

debug wcep event debu weep packet

A



WCCP Zx|apio|ME 8t FDM 2 FMC 7|2 EEE x|§Hst7| {8t Cisco H2
IDCSCvn905180| A A& LIC.


https://tools.cisco.com/bugsearch/bug/CSCvn90518
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